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คํานํา

PHP น้ันเปนหนึ่งในภาษาสคริปตสําหรับพัฒนาเว็บไซตที่ไดรับความนิยมสูงสุด เนื+องจากไมมีกฎเกณฑหรือ

โครงสรางทางภาษาท่ีซับซอน ผูศึกษาจึงสามารถเรียนรูไดในระยะเวลาอันสั้น สวน MySQL ก็เปนฐานขอมูล

ระดับกลางที่มีประสิทธิภาพการทํางานสูง และที่สําคัญคือนํามาใชงานไดฟรี ท้ังนี้ใน PHP นั้นมีฟงกชั่นสําหรับฐาน

ขอมูล MySQL โดยเฉพาะจึงทําใหการใชงานรวมกันระหวาง PHP และ MySQL ทําไดโดยงาย สะดวก รวดเร็ว 

และมีประสิทธิภาพ

อีกสิ่งหนึ่งที่เราควรจะรูสําหรับการสรางเว็บไซตในยุคปจจุบัน นั่นก็คือการเขียนคําสั่งสคริปตในแบบ jQuery 

ซึ่งเปนไลบรารี่ของจาวาสคริปต เพื+อกําหนดกระบวนการตางๆ ภายในเพจใหทํางานตามเงื+อนไขที่ตองการได โดย 

jQuery นั้นมีคําสั่งใหเราเลือกใชมากมาย และสามารถใชไดกับทุกเบราเซอรโดยไมมีปญหาเรื+องทํางานที่ผิดเพี้ยน

แตอยางใด ทั้งนี้เราสามารถนํา jQuery มาใชงานรวมกับ PHP ในการรับสงขอมูลระหวางกันผานทาง AJAX ทําให

เว็บไซตเกิดการตอบสนองที่รวดเร็วกวารูปแบบเดิมมาก

หนังสือเลมนี้มุงหวังที่จะถายทอดความรูและประสบการณของผูเขียนจากการพัฒนาเว็บดวย PHP/MySQL 

และ jQuery มาเปนเวลานานพอสมควร เพื+อใหผูที่สนใจดานการพัฒนาเว็บนําไปศึกษาเรียนรูไดดวยตนเอง โดยได

กลาวถึงเรื+องที่สําคัญที่จําเปนตอการสรางเว็บเอาไวอยางครบถวน รวมถึงแนวทางการประยุกตใชงานที่หลากหลาย 

ดงัน้ันผูเขยีนจงึหวงัวาความรูทัง้หมดจากหนงัสอืเลมนีจ้ะชวยใหผูอานสามารถนําไปพัฒนาเวบ็ไซตใหสามารถใชงาน

ไดจริงตามที่ตองการ

บัญชา  ปะสีละเตสัง

banchar_pa@yahoo.com

facebook.com/developerthai
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1
ารสรางเว็บแอปพลิเคชั่นดวย PHP รวมกับ MySQL และ jQuery ตามที่จะกลาวถึงในหนังสือเลมนี้ ตองเริ่ม

ดวยการติดตั้งระบบพรอมเซตคาที่จําเปนตอการทํางานของระบบเสียกอน ตามท่ีจะไดกลาวถึงในบทนี้ แลว

หลังจากนั้นก็จะกลาวถึงองคประกอบที่เราจําเปนตองรูจักในเบื้องตนของการสรางเว็บแอปพลิเคชั่นเพื+อเปนพ้ืนฐาน

สําหรับนําไปใชงานในบทตอๆ ไป

เครื�องมือที่ตองใชในการพัฒนาเว็บ
กลไกการทํางานของระบบเว็บนั้น จะเริ่มจากการสงคําสั่งรองขอขอมูลจากผูใช (เว็บเบราเซอร) ไปยังเว็บ

เซิรฟเวอร จากนั้นเว็บเซิรฟเวอรก็จะเรียกตัวประมวลผลมาจัดการกับการรองขอน้ัน เมื+อไดผลลัพธออกมาก็จะสง

ผานเว็บเซิรฟเวอรกลับไปยังเบราเซอร ดังแผนภาพโดยสังเขปตอไปนี้

การจัดเตรียมระบบ
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การท่ีจะเกดิเปนระบบเวบ็ทีส่ามารถทาํงานไดดงักลาวนัน้ เราจําเปนตองมกีารตดิต้ังโปรแกรมบางอยางลงไป

พรอมกับเซตคาใหโปรแกรมเหลานั้นสามารถทํางานรวมกันใหไดเสียกอน เราจึงจะเขาสูขั้นตอนการพัฒนาเว็บแอป

พลิเคชั่นในขั้นตอไปได ทั้งนี้โปรแกรมที่จะตองใชมีดังตอไปนี้

 โปรแกรมเว็บเซิรฟเวอร - เปนตัวที่จะควบคุมและจัดการทรัพยากรทั้งหมดในการทํางานของระบบเว็บ 

ดงันัน้เว็บเซริฟเวอรจงึถอืไดวาเปนสิง่จาํเปนอนัดบัแรกทีจ่ะตองม ีสาํหรบัในทีน่ีจ้ะเลือกใช Apache เปน

เว็บเซิรฟเวอร

 โปรแกรมภาษาสาํหรบัประมวลผล - เปนตวัประมวลผลคาํสัง่หรอืโปรแกรมทีเ่ราเขยีนเพื+อใหไดผลลพัธ

ออกมาตามที่ตองการ สําหรับในที่นี้เลือกใช PHP เปนตัวประมวลผล

 โปรแกรมฐานขอมูล - เปนตัวเสริมการทํางานเพื+อใชในการจัดเก็บขอมูลของระบบเว็บ ซึ่งจะมีหรือไม

ก็ได สําหรับในที่นี้เลือกใช MySQL เปนฐานขอมูล

 โปรแกรมสําหรับสรางเว็บหรือเขียนโคด - ถาเราตองการเขียนโคดลงไปเองทั้งหมดก็อาจเลือกใช

โปรแกรมพวก Text Editor เชน Notepad หรือ EditPlus แตหากตองการแบบที่มีเครื+องมือมาชวยดวย

ก็อาจใชโปรแกรม Dreamweaver เปนตน สําหรับในที่นี้จะเลือกใช Dreamweaver

สําหรับเว็บเซิรฟเวอร, โปรแกรมภาษา และฐานขอมูลนั้น ปกติจะเปนโปรแกรมที่แยกจากกันโดยอิสระ ซึ่ง

เราตองนํามาติดตั้งลงไปทีละตัวแลวเซตคาใหทํางานรวมกันได จึงทําใหเกิดความยุงยาก ดังนั้นจึงไดมีผูคิดสรางชุด

เครื+องมือสําหรับเปนตัวชวยในการติดตั้งโปรแกรมท้ัง 3 อยางลงไปพรอมกันแลวเซตคาที่จําเปนตอการทํางานใน

เบือ้งตนใหเราพรอมใชงานไดทนัทซีึง่ชุดเครื+องมอืดงักลาวชื+อวา XAMPP สําหรบัรายละเอยีดจะกลาวถงึในหัวขอตอ

ไป สวน Dreamweaver นั้นเปนโปรแกรมที่แยกจากตัวอื+นๆอยางชัดเจนอยูแลว แตสามารถเชื+อมโยงกับ XAMPP 

ได ซึ่งรายละเอียดจะกลาวถึงในลําดับตอไป

การติดตั้ง XAMPP
กอนการตดิตัง้เราตองไปดาวนโหลดชุดติดต้ัง XAMPP มากอนโดยดาวนโหลดไดที ่http://htdocs.apache-

friends.org ใหเลือกเวอรชั่นที่ตรงกับระบบปฏิบัติการที่เราใชอยู หลังดาวนโหลดก็เขาสูขั้นตอนการติดตั้งดังนี้

1. หลังจากดาวนโหลดมาแลว ดบัเบิล้คลกิทีไ่ฟลทีด่าวนโหลดมาจะเขาสูขัน้ตอนการติดต้ังเหมือนโปรแกรม

ทั่วไป

2. ในขัน้ตอนเลอืกโปรแกรมท่ีจะตดิตัง้ จะเลอืกทัง้หมดหรือบางสวนกไ็ด ซึง่สิง่ทีต่องใชงานในหนงัสอืเลมนีค้อื  

Apache, MySQL, PHP และ phpMyAdmin

3. ในขั้นตอนการกําหนดตําแหน[งติดตั้ง ในที่นี้จะใชคาดีฟอลตคือ C:\xampp

4. จากนั้นเขาสูการติดตั้งจนกวาจะเสร็จ 
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เริ่มตนการใชงาน XAMPP
หลังจากติดตั้ง XAMPP ไปแลวใหเปดเขาสู XAMPP Control Panel ซึ่งจะมีลักษณะดังภาพ 

สิง่ท่ีเราตองทาํเปนอันดับแรกคอืตองเริม่ตนการทาํงานของ Apache ซ่ึงเปนเว็บเซริฟเวอรใหไดเสยีกอนโดย

การคลิกที่ปุม Start และหากไมมีขอผิดพลาด ก็จะปรากฏแถบสีเขียวตรงคําวา Apache พรอมคา PID และ Port 

แสดงวาเว็บเซิรฟเวอรและ PHP พรอมใชงานไดแลว 
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เราสามารถทดสอบไดโดยคลิกปุม Admin ตรงแถวของ Apache ซึ่งจะเปดเขาสูเว็บเพจสําหรับเซตคาของ 

Apache 

หลังจาก Apache ทาํงานแลวกส็ามารถปด XAMPP Control Panel ไปไดเลย ตอไป Apache จะเร่ิมตนการ

ทํางานเองโดยอัตโนมัติเมื+อเราเปดเครื+องขึ้นมา จึงไมจําเปนตองเปด XAMPP มาสั่งใหเริ่มตนการทํางานแบบนี้อีก 

(ยกเวนจะสั่ง Stop คางเอาไว) สําหรับกรณีที่เราไมสามารถเริ่มตนการทํางานของ Apache ไดสวนใหญจะเกิดจาก

การทีเ่ราตดิตัง้ชดุแพค็เกจทีม่ ีApache ซํา้ซอนกนั เชน อาจตดิต้ัง Appserv, WAMP หรืออื+นๆ ลงในเครื+องเดยีวกนั  

ทําใหเกิดปญหาการใชพอรตรวมกัน ซึ่งเราสามารถแกปญหาโดยหยุดการทํางานของ Apache บนแพ็คเกจอื+นแลว

คอยมาเริ่มตน Apache ของ XAMMP ใหม

สวน MySQL นั้นเนื+องจากเรายังไมไดใชงานในตอนนี้ จึงยังไมตองเริ่มการทํางานก็ได สําหรับรายละเอียด

ทั้งหมดจะนําไปกลาวถึงในบทที่เปนเนื้อหาเกี่ยวกับ MySQL โดยตรง

การแกไขออปชั่นของไฟล php.ini
ในบางกรณีเราอาจจําเปนตองเซต 

ออปชั่นการทํางานของ PHP ใหเหมาะสม

กับการใชงานของเราเอง ซึ่งออปชั่นตางๆ 

จะถกูกําหนดเอาไวในไฟล php.ini ทัง้นีเ้รา

สามารถเปดไฟลนีไ้ดจาก XAMPP Control 

Panel โดยคลิกทีปุ่ม Config ตรงชองแถว 

Apache แลวเลือก php.ini จากนั้นไฟล

จะถูกเปดใน Notepad (กรณีใชวินโดวส) 
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ออปชั่นตางๆ ในไฟล php.ini มีคอนขางมาก ซึ่งคาดีฟอลตที่ PHP ตั้งไวใหนั้นสวนใหญก็เหมาะสมดีอยูแลว 

ทั้งนี้หากเราจําเปนตองแกไขออปชั่นใด จะนําไปกลาวถึงในเรื+องที่เกี่ยวของ สําหรับในเบื้องตนนี้ผูเขียนแนะนําให 

แกไขออปชั่นการแสดงคําแจงเตือน โดยหลังจากเปดไฟล php.ini ใหคนหาบรรทัดตอไปนี้

error_reporting=E_ALL

ปกติคาเดิมที่ตั้งเอาไวคือ E_ALL หมายถึงใหแจงขอผิดพลาดและคําเตือนในทุกกรณี แตในบางคร้ังขอ 

ผดิพลาดท่ีแจงมานัน้เปนเพยีงการตัง้ขอสงัเกต (Notice) ซึง่ไมใชขอผดิพลาดท่ีทาํใหโปรแกรมตองหยดุทาํงาน โดย

เราไมจําเปนตองสนใจคําแจงเตือนนี้ก็ได ดังนั้นเพื+อไมใหเกิดความยุงยากในการเขียนโคดจนเกินไป ผูเขียนแนะนํา

ใหแกไขออปชั่นดังกลาวนี้เปนดังนี้

error_reporting= E_ALL & ~E_NOTICE & ~E_STRICT & ~E_DEPRECATED

หมายความวาใหแจงขอผิดพลาดทุกกรณียกเวนขอ

สงัเกตและคาํเตอืนหากใชฟงกชัน่ทีอ่ยูในสถานะ Deprecated 

หลังจากนั้นใหบันทึกการเปลี่ยนแปลงแลวกลับมาที่ XAMPP 

Control Panel ใหสั่งหยุด (Stop) การทํางานของ Apache 

กอนแลวสั่งเริ่มตนใหม (Start) 

หมายเหตุ 

ในหนงัสอืเลมนีผู้เขยีนจะอางองิการตัง้คาของออปช่ัน error_reporting ตามน้ี ดงัน้ันหากผูอานดาวนโหลดโคดมาใช

แตไมไดตั้งคาตามนี้ ในบางตัวอยาง/เวิรคช็อป/โปรเจ็กต อาจจะปรากฏคําแจงเตือนขึ้นมาก็ได

รูจักกับตําแหนง Document Root
เมื+อเราเลือกท่ีจะสรางและจัดการเว็บเพจบนระบบเว็บเซิรฟเวอร สิ่งที่เราควรรูจักในเบื้องตนก็คือตําแหน[ง 

Document Root ซึ่งเปนตําแหน[งอางอิงใน

การจัดเก็บไฟลเว็บเพจและไฟลอื+นๆ ที่เกี่ยวของ 

สําหรับเว็บเซิรฟเวอรที่เราติดตั้งจาก XAMPP 

ตําแหน[งนี้จะอยูที่

C:\xampp\htdocs
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ไฟลเว็บเพจที่เราสรางขึ้นรวมถึงไฟลที่เกี่ยวของ จะตองนํามาเก็บไวที่นี่ เมื+อเราตองการเปดดูเว็บเพจใดดวย

เบราเซอร ใหแทนตําแหน[ง C:\xampp\htdocs ดวย http://localhost แลวตามดวยไฟลเว็บเพจนั้น เชน สมมติวา

เราสรางเพจชื+อ hello.html จัดเก็บไวที่ 

C:\xampp\htdocs\hello.html จะตองกําหนด URL เปน http://localhost/hello.html

หรอืถาสรางโฟลเดอรยอยซอนไวในโฟลเดอร htdocs กต็องกาํหนดเสนทางถดัจาก htdocs เขาไปจนถงึไฟล

นั้น เชน สมมติวาตําแหน[งการจัดเก็บไฟลเปน

C:\xampp\htdocs\example\test.html ตองกําหนด URL เปน http://localhost/example/test.html 

สรุปแลวก็คือ ใหแทน C:\xampp\htdocs ดวย http://localhost ตามดวยเสนทางที่อยูถัดจากโฟลเดอร 

htdocs ไปจนถึงไฟลนั้น สําหรับไฟลของตัวอยางตางๆ ในแตละบทของหนังสือเลมนี้ ผูเขียนไดใชรูปแบบการจัด

เก็บดังนี้คือ

 สรางโฟลเดอรชื+อ pmj ซอนไวใน htdocs เพื+อแยกจัดเก็บโคดในหนังสือเลมนี้โดยเฉพาะ

 ไฟลในแตละบทจะแยกจากกัน โดยสรางโฟลเดอรยอยชื+อ example\chapX สําหรับแตละบท ซอนไว

ในโฟลเดอร pmj เชน

 ๏ ไฟลตัวอยางของบทที่ 2 จะอยูที่ C:\xampp\htdocs\pmj\example\chap2

 ๏ ไฟลตัวอยางของบทที่ 3 จะอยูที่ C:\xampp\htdocs\pmj\example\chap3

 ๏ ...บทอื+นๆ ก็มีลักษณะเดียวกัน...

เนื+องจากในแตละตัวอยางอาจมีไฟลประกอบ

มากกวา 1 ไฟล ดังนั้นจึงจะสรางโฟลเดอรแยกเฉพาะ

สําหรับแตละตัวอยางอีก เชน เพจหลักของตัวอยางที่ 2-1 

ของบทท่ี 2 ก็จะอยูที่ตําแหน[ง C:\xampp\htdocs\pmj\

example\chap2\2-1\index.php เปนตน ดังนั้นถาจะเปดดูตัวอยางนี้ก็ตองระบุ URL ในลักษณะดังนี้คือ http://

localhost/pmj/example/chap2/2-1/index.php
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การใช Dreamweaver รวมกับ XAMPP
ในหนังสอืเลมนีจ้ะเลือกใช Dreamweaver ในการสรางเว็บเพจ เนื+องจากมเีครื+องมอืทีช่วยอาํนวยความสะดวก

มากมายทั้งในการเขียนโคด, การออกแบบ และการทดสอบ สําหรับการติดตั้ง Dreamweaver นั้นคาดวาผูอานคง

ตดิตัง้ไดอยูแลว ดงันัน้จะไมกลาวถงึในสวนนี ้โดยมรีายละเอียดการใชงานท่ีเราควรรูในการใชรวมกบั XAMPP ดงันี้ 

(ในหนังสือเลมนี้ใช Dreamweaver CS6)

การที่เราจะใช Dreamweaver รวมกับระบบเว็บเซิรฟเวอรไดนั้น เราตองสรางไซตใน Dreamweaver กอน 

ซึง่ไซตทีส่รางขึน้นีก้เ็พื+อจะเชื+อมโยงไปยังไฟลตางๆ ทีอ่ยูใน Document Root ใหเราสามารถสราง, เปดดู, แกไข หรอื

ทดสอบเว็บเพจเหลานั้นผานทาง Dreamweaver ไดนั่นเอง สําหรับขั้นตอนการสรางไซตใน Dreamweaver มีดังนี้

1. เมื+อเปดเขาสูโปรแกรม Dreamweaver เลือกที่เมนู Site > New Site

2. ขั้นตอนถัดไปมีดังนี้

1) ที่แท็บดานซายมือ ใหคลิกเลือก Site

2) กําหนดขอมูลแตละชองดังนี้

 Site Name กําหนดเปน localhost

 Local Site Folder กําหนดเปน C:\xampp\htdocs

3) คลิกปุม Save
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3. ขั้นตอนถัดไปมีดังนี้

1) ที่แท็บดานซายมือ ใหคลิกเลือก Server

2) คลิกที่รูปเครื+องหมาย + เพื+อเพิ่มเซิรฟเวอร

4. ขั้นตอนถัดไปมีดังนี้ (ภาพดานลางซายมือ)

1) เลือกแท็บ Basic

2) กําหนดขอมูลในชองตางๆ ดังนี้

 Server Name กําหนดเปน localhost

 Connect Using กาํหนดเปน Local/

Network

 Server Folder กาํหนดเปน C:\xampp\htdocs

 Web URL กําหนดเปน http://localhost

3) คลิกปุม Save
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5. ขั้นตอนถัดไปมีดังนี้ (ภาพหนาที่แลวดานขวามือ) 

1) เลือกแท็บ Advance

2) ชอง Server Model กําหนดเปน PHP MySQL

3) คลิกปุม Save

6. ขั้นตอนถัดไปมีดังนี้ 

1) เช็คเลือกที่ชอง Testing

2) คลิกปุม Save

การติดตัง้ Site กม็ขีัน้ตอนเพยีงเทานี ้หลงัจากนัน้เมื+อกลบัเขาสูหนาจอหลกั

ของ Dreamweaver ที่แท็บ Files จะโหลดไฟลตางๆ ที่มีอยูใน Document Root 

ซึ่งในที่นี้คือ C:\xampp\htdocs มาแสดงดังภาพ (ถาไมปรากฏแท็บ Files ใหเลือก

จากเมนู Window > Files หรือกด <F8>) 

ปกติแลว Dreamweaver จะตั้งคา Preference เกี่ยวกับองคประกอบตางๆ ของเอกสาร HTML ไวใหเรา

ลวงหนาแลว แตอยางไรก็ตาม คาบางอยางที่ตั้งไวใหนี้อาจตองแกไขใหม เพื+อใหตรงกับการนําไปใชงานจริงของเรา 

ซึ่งขั้นตอนการตั้งคาที่สําคัญมีดังนี้
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1. เลือกที่เมนู Edit > Preferences...

2. คลิกที่แท็บ Fonts แลวเลือกกําหนดคาดังนี้

 ๏ Font settings: เลือก Unicode

 ๏ Proportional font: และ Code 

view: ใหเลือกชนิดฟอนตที่รองรับ

ภาษาไทยได เชน ในที่นี้ผู เขียน

เลือก Tahoma ท้ังสองชอง และ

เลือกขนาด (Size) เปน 10pt

3. คลิกที่แท็บ New Document  แลวเลือกกําหนดคาดังนี้

 ๏ Default document:/extension: 

กําหนดเปน PHP และ .php ตาม

ลําดับ

 ๏ Default Document Type(DTD): 

กําหนดเปน HTML 5

 ๏ Default encoding: กําหนดเปน 

Unicode (UTF-8)

ใน Dreamweaver นั้นหากเราจะเปดดูผลลัพธของเว็บเพจที่สราง

ขึ้น ใหคลิกที่ไอคอนดังภาพ ซึ่งจะมีรายชื+อเบราเซอรใหเลือกเปดไดตาม

ตองการ เนื+องจากในบางกรณีนั้นผลลัพธที่ไดในแตละเบราเซอรอาจจะไม

เหมอืนกนั ดงันัน้เราควรเลอืกทดสอบกบัเวบ็เบราเซอรหลายๆ ตวั แตหาก

ไมมรีายชื+อเบราเซอรใหเลอืกตามน้ี เราสามารถเพิม่เบราเซอรอื+นๆ เขามา

ตามตองการ โดยมีขั้นตอนดังนี้ 

1. เมื+อคลิกที่ปุมทูลบารตามภาพที่แลวใหเลือกเมนู Edit Browser List... หรือเลือกจากเมนู Edit >  

Preferences...

2. หลังจากนั้นจะเขาสูหนาจอ Preferences แลวที่ชอง Category เลือก Preview in Browser
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3. ถาตองการเพิ่มเบราเซอรใหคลิกปุมเครื+องหมาย + จากน้ันเมื+อปรากฏไดอะล็อก Add Browser ก็ให

กําหนดชื+อที่ใชเรียกเบราเซอรนั้นในชอง Name และชอง Application ใหเลือกไฟลที่เรียกเบราเซอรนั้น

ขึ้นมาทํางาน  ตําแหน[งไฟลที่เราตองนําไปใสในชอง Application ตามคาดีฟอลตของเบราเซอรตัวที่น[า

สนใจมีดังนี้ (อางอิงตามเครื+องของผูเขียน)

 ๏ Chrome - C:\Users\user\AppData\Local\Google\Chrome\Application\chrome.exe

 ๏ Firefox - C:\Program Files (x86)\Mozilla Firefox\firefox.exe

 ๏ IE - C:\Program Files\Internet Explorer\IEXPLORE.EXE

 ๏ Opera - C:\Program Files (x86)\Opera\launcher.exe

 ๏ Safari - C:\Program Files (x86)\Safari\Safari.exe

หลังจากเพิ่มเบราเซอรเขาไปแลว หากตองการลบหรือแกไขขอมูลของตัวใด ก็คลิกเลือกที่ชื+อเบราเซอรนั้น

กอนแลวคลิกปุมเครื+องหมาย - หรือปุม Edit ตามลําดับ

การสรางเพจใหม หากในเพจนั้นจะตองมีสคริปต PHP อยูดวย ใหเลือกชนิดไฟลเปน PHP ทั้งนี้เพื+อให 

Dreamweaver นําเครื+องมือมาชวยในการเขียนโคด PHP ดวย เชน ตรวจสอบขอผิดพลาด, Code Hint เปนตน 

ซึ่งการสรางเพจใหมมีวิธีใหเราเลือกใชตามความสะดวก ดังนี้

  วิธีที่ 1 คลิกเลือกจากเมนู HTML เมื+อปรากฏหนาจอ Welcome Screen ดังภาพดานลาง (ถาซอน

หนาจอนี ้แลวตองการกลบัมาแสดงอกี ใหเลอืกจากเมนู Edit > Preferences...> ชอง Category เลือก  

General > เชก็เลอืก Show 

Welcome Screen)
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  วิธีที่ 2 เลือกจากเมนู File > New... หรือกด <Ctrl + N> จากนั้นจะปรากฏวินโดวดังภาพดานลาง 

ก็ใหเลือกตามลําดับดังหมายเลขในภาพ 

สาํหรบัการใชงาน Dreamweaver ท่ีไดกลาวมาท้ังหมดในบทนี ้เปนเพยีงลกัษณะพืน้ฐานบางสวนทีเ่กีย่วของกบั  

PHP เทานั้น สวนการใชงานในลักษณะอื+นๆ ซึ่งไมอยูในขอบเขตของหนังสือเลมนี้ จึงขอใหผูอานศึกษาเพิ่มเติมจาก

หนังสือที่เกี่ยวกับ Dreamweaver โดยตรง

การนําโคดของหนังสือมาใชงาน
เนื+องจากโคดของตัวอยาง/เวริคชอ็ป/โปรเจก็ตในหนงัสอืเลมนี ้จะนาํมาแสดงเพยีงบางสวนเทานัน้ หากผูอาน

ตองการดโูคดแบบเตม็ๆ ท้ังหมด สามารถดาวนโหลดไดที ่http://www.developerthai.com หลงัจากดาวนโหลดมาแลว  

ใหทําดังนี้

 ขยายไฟล .zip ซึ่งโคดทั้งหมดจะถูกเก็บอยูในโฟลเดอร pmj

 นาํโฟลเดอร pmj ไปเก็บไวที ่Document Root ซึง่ตามการอางองิในหนังสอืเลมนีค้อื C:\xampp\htdocs 

 ในโฟลเดอร pmj จะมีทุกอยางที่ประกอบในหนังสือแนบมาใหดวยทั้งหมด เชน โคดของทุกตัวอยาง/

เวิรคช็อป/โปรเจ็กต, ฐานขอมูล (อยูในโฟลเดอร data), ไลบรารี่ PHP, ไลบรารี่ JavaScript รวมถึง

รูปภาพประกอบทั้งหมด
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 บทที่ 1    37

 กรณีฐานขอมูล ซึ่งอยูในรูปแบบไฟล .sql ใหนําเขา (Import) ไปใน MySQL ผาน phpMyAdmin ตาม

วิธีการที่จะอธิบายในบทที่ 8

 การเชื+อมตอกับฐานขอมูล ในหนังสือเลมนี้ผูเขียนตั้งรหัสผานเปน abc456 ซ่ึงผูอานตองแกไขโคดที่มี

การเชื+อมตอกับฐานขอมูลใหตรงกับของผูอานเอง หรือถาไมอยากแกไขก็กําหนดรหัสผานเปน abc456 

ไปกอนก็ได ซึ่งการกําหนดรหัสผานของ MySQL จะกลาวถึงในบทที่ 8

 หากมีปญหาใดๆ ในการใชงานสามารถติดตอไดที่ banchar_pa@yahoo.com ซึ่งหากไมไดรับการตอบ

กลับภายใน 2-3 วัน ใหติดตอใหมอีกครั้ง :)
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